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MIMIC Release Notes
April 25, 2008

All enhancements and bug fixes in the release candidates are included in the final release. For more
information on enhancements included in this release, please see the MIMIC Product News.

Release 4.0.1.1
Build 1.306.2.20 2008/04/25:

Enhancements:

#AT1382 (Enhancement) MIMIC: About box modified to allow user to select all the text to facilitate sending
information to client support.

#AT1616 (Enhancement) MIMIC: License checking removed until a better solution can be provided for
companies with large user base.

Bug Fixes:

#AT1606 (Bug Fix) MIMIC: Fixed location of notes dialog to always display on screen when adding notes to
a chart.

Release 4.0.1

Release Candidate 4.0.0.2
Build 1.306.2.11 2008/03/06:

Bug Fixes:

#AT1193 (Bug Fix) MIMIC: Change thickness of lines doesn't seem to work.

Release Candidate 4.0.0.1
Build 1.306.2.10 2008/02/26:

Bug Fixes:

#AT1086 (Bug Fix) MIMIC: The chart legend is cutting off no matter how the window is resized.

http://customers.lim.com/pdfdocs/mimic_prodnews_4.pdf
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#AT1087 (Bug Fix) MIMIC: The browser "select" popup window is not working on first attempt.

#AT1088 (Bug Fix) MIMIC: The browser multi-select is not working.

#AT1089 (Bug Fix) MIMIC: When clicking “New Worksheet”, application is not releasing the old file and
not prompting when saving thus causing the previously saved file to be overwritten.

#AT1090 (Bug Fix) MIMIC: InvalidClass Exception: Users were unable to share worksheets due to a
serialization problem.

#AT1091 (Bug Fix) MIMIC: After charting query and changing colors in the Chart Configuration, turning on
the View>Chart>Options>Controls, and clicking the Mouse Pick Off Button, the colors are not updating.

#AT1092 (Bug Fix) MIMIC: When printing a chart in color, and selecting Options>Color Print and then
changing the Color Print settings in the Color Print tab of the Chart Configuration window, the chart printed
in the color that was defined on the Chart Configuration tab, not on the Color Print tab.

#AT1093 (Bug Fix) MIMIC: Intraday date format in table does not show a two digit minute. When
tabling intraday data the format for the datetime is H:M:S. There was no zero padding. Format should be
HH:MM:SS.

#AT1094 (Bug Fix) MIMIC: Default values for "Show Summary Stats" and "Sort Date Ascending" should be
set to what the user has in property file. The default value is "true" if the property does not exist.

Release Candidate 4.0.0.0
Build 1.306.2.8 2008/02/22:

Enhancements:

Incident 15874, #AT7 (Enhancement) MIMIC: User has control of Y-axis in a chart.

Incident 38581, #AT14 (Enhancement) MIMIC: You can now right click in the "Chart Type" column and
make all the items the same chart type.

Incident 44831, #AT15 (Enhancement) MIMIC: When there are more than 100 results then the results may
be limited by the server. There is now a message on the Report: "Found 100 Results. (Results may be limited
to 100 by the server.)"

Incident 45815, #AT20 (Enhancement) MIMIC: Enabled user to refresh the browser tree.

#AT52 (Enhancement) MIMIC: The new installer for MIMIC does not require configuration. The host
and port are located by the application and will prompt the user if not found. The installer just needs to
know where to install the application and if the MIMICExcel Add-in should be installed (default is to install
the Add-in). The host and port numbers are managed in the new Connection Manager, where these server
connections can be added and edited.

Incident 17882, #AT60 (Enhancement) MIMIC: The user can now add text notes onto a MIMIC graph.

Incident 23390, #AT65 (Enhancement) MIMIC: Allows the user to define the line thickness for each series
of data on the chart. Similar to Color Configuration.
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Incident 32935, #AT66 (Enhancement) MIMIC: The user can now specify the symbols to use for each data
series in a chart. Similar to Color Configuration.

Incident 35648, #AT67 (Enhancement) MIMIC: Allows the user to select multiple items in the tree view and
drag them to the "Add to Favorites" button. The Favorites dialog is updated to be more like a file chooser
dialog with a filter for .itm files.

Incident 44719, #AT68 (Enhancement) MIMIC: Allow the user to use the arrow keys and the Enter key to
control the mouse pick lines. Left, right, up and down arrows move one pixel at a time. The Enter key will
lock in the current selection, similar to a mouse click.

Incident 25321, #AT69 (Enhancement) MIMIC: Results in portrait/landscape format. Currently results are
formatted in the table where columns="values for a relation" and rows ="dates for the values". The User can
now change it to: columns="dates for values" and rows="values for a relation"

Bug Fixes:

Incident 20786, 22332, #AT8 (Bug Fix) MIMIC: Added quarterly execution units to Seasonal Analysis.

Incident #AT7 (Bug Fix) MIMIC: Updated the date controls in the Curve Item pane and the Seasonal
Analysis dialog window so that they conform to match the User Preferences window.

Incident 44833, #AT49 (Bug Fix) MIMIC: What a relation is entered the "Time Units" should be set to the
default units for that relation.

Incident 41117, #AT61 (Bug Fix) MIMIC: The user is prompted for a different host and port when the
specified server does not respond.

Incident 38432, #AT63 (Bug Fix) MIMIC: The user is allowed to cancel a search.

Incident 40366 (Bug Fix) MIMIC: When using the curve tab, the chart label did not change to match the
chart date. Now, touching the date controls sets the label to the appropriate date (or "Last Data Day").

Incident 46189 (Bug Fix) MIMIC: MIMIC did not remove the tag descriptions for FTI data in the Label/
Configuration area. Descriptions will now display properly.

Incident 42586 (Bug Fix) MIMIC: If a user created a MIMIC curve from the Curve tab without entering a
valid symbol a blank error message displayed. Now, a meaningful error message displays.

Release 3.2.0.4
Build 1.228.4.36 2007/11/29:

Time Units (Bug Fix) MIMIC: When choosing "Secondly" for the time units of individual items the query
was being created incorrectly. Changed from "Secondly" to "Seconds".

Incident 45860 (Bug Fix) MIMIC (Defect ID #1426): Formula Description Table Summary appears twice.
Table statistics were not being calculated for Bar columns.
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Release 3.2.0.3
Build 1.228.4.35 2007/10/04:

Incident 43498 (Bug Fix) MIMICExcel: When closing MIMIC, if you use the X to close the form then Excel
hangs when re-entering MIMIC. Fixed by changing the behavior of the red X to hide the form instead of
terminating MIMIC.

Release 3.2.0.2
Build 1.228.4.33 2007/09/21:

Incident 39751 (Bug Fix) MIMIC: Bug in the MIMICExcel query description dialog. Fixed by increasing the
height of the controls.

Incident 44083 (Bug Fix) MIMICExcel: When a mistake is made in MIMICExcel, the error prompt causes
MIMICExcel to hang. Fixed by removing callback from VBA.

Incident 43498 (Bug Fix) MIMICExcel: Hanging on errors and relocating embedded queries. Relocating
queries has been fixed. Error dialogs fixed.

Incident 44275 (Bug Fix) MIMICExcel: Receiving errors when launching Excel after uninstalling MIMIC.
Fixed by moving the uninstall action up in the UI sequence.

Incident 43426 (Bug Fix) MIMICExcel: When using the new MIMICExcel, clicking on Open says Loading...
and then freezes. Fixed by removing the callback from VBA.

Release 3.2.0.1
Build 1.228.4.26 2007/08/10:

Issue 43495 (Enhancement) MIMIC: Add LmpVal to the list of preferred columns. This allows LmpVal to
be the default column if no other preferred column is found. Fixed by adding LmpVal to the list of preferred
columns.

Issue 43439 (Bug Fix) MIMICExcel: Errors when removing mimic excel add-in. Added error trapping in the
install.xls macros.

Issue 43426 (Bug Fix) MIMICExcel: When using the new MIMICExcel, clicking on Open says Loading...and
then freezes. Fixed by reworking threads.

Issue 43557 (Bug Fix) MIMICExcel Add-In: Program freezes when trying to table a query and “No Data”
error. Fixed by placing error dialog on AWT thread.
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Issue 43690 (Bug Fix) MIMIC: Favorites does not insert when in insert mode. Only appends. Fixed to insert
if in “insert” mode.

Issue 43615 (Bug Fix) MIMICExcel: Queries not sorting by date as specified in worksheet when refreshing
MIMIC Queries. Fixed.

Release 3.2.0.0
Build 1.228.4.22 2007/08/01:

Issue #43415 (Bug Fix) MIMICExcel: Fixed bug to give status bar control back to application.

Build 1.228.4.22 2007/08/01:

Issue #43433 (Bug Fix) MIMIC: Fixed Curve Matrix Tool to not format numbers with a comma.

Build 1.228.4.21:

Issue #43186 (Bug Fix) MIMIC: Color configuration not being saved when changes are made.

Build 1.228.4.19:

Issue #43036 (Bug Fix) MIMIC: Curve matrix giving error when expiration date not set on relation. Fixed to
be more aggressive in trying to get the expiration day.

Build 1.228.4.17:

Issues #41266, 42698 (Bug Fix) MIMIC: User preference window fails to launch.

Build 1.228.4.16:

Issue #31411 (Enhancement) MIMIC: Save worksheet contents and properties to file.

Issue #35796 (Enhancement) MIMIC: Enabled user to execute Chart/Table from the browser/search
window.

Issue #36591 (Enhancement) MIMIC: When a query causes an error due to an item in the sheet, MIMIC
attempts to find the row in the table and highlights it.

Issue #37038 (Enhancement) MIMIC: Added “Avg Day Monthly” to line items for building queries that
show the “monthly average of an hourly price”.

Issue #38083 (Enhancement) MIMIC: Search defaults to descriptions or symbols based on users last
selection.

Issue #38114 (Enhancement) MIMIC: Mouse copy, paste, delete and insert items from item table.

Issue #38219 (Enhancement) MIMIC: Allow user to add to Favorites from Browser panel.

Issue #38230 (Enhancement) MIMIC: Added default value for “Show table stats”.

Issue #38249 (Enhancement) MIMIC: Added Worksheet property to include/exclude weekend values.
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Issue #39127 (Enhancement) MIMICExcel: MIMICExcel Save/Open menu items are now more consistent
with stand-alone version.

Issue #39272 (Bug Fix) MIMIC: Queries with curve items now try and get the expiration date from the MIM.

Issue #34116 (Bug Fix) MIMIC: Fixed bug that kept embedded queries from refreshing and having to be
tabled manually.

Issue #36330 (Bug Fix) MIMIC: Seasonal chart label bug fixed for items that are invisible.

Issue #36561 (Bug Fix) MIMICExcel: MIMICExcel locks up when user opens saved query numerous times.

Issue #37812 (Bug Fix) MIMIC: Name of the days now appear on the calendar in MIMIC Curve tab.

Issue #38500 (Bug Fix) MIMIC: Legends in Seasonal Charts with a baseline are showing correctly.

Release 3.1.0.7
Issue #31411 (Enhancement) MIMIC: Save worksheet contents and properties to file.

Issue #32794 (Enhancement) MIMIC: Multi-select capability for search results.

Issue #33678 (Bug Fix) MIMIC: "All Data" Change needs tailoring. When "All Data" is selected: If "Relative"
is on then WHEN condition is empty. If "Relative" is off WHEN condition is from start date to last data
date.

Issue #31544 (Bug Fix) MIMIC: Seasonal Table Not working for weekly.

Issue #32204 (Bug Fix) MIMIC: Button images causing problem in add-in.

Issue #32976 (Bug Fix) MIMIC: Search control fetching descriptions locks MIMIC.

Issue #33206 (Bug Fix) MIMIC: Number of Units not being saved.

Release 3.1.0.6
Issue #32649 (Enhancement) MIMIC: ”llc - Hotlist Browser”. To be consistent we need to call it “MIMIC –
Favorites Browser”.

Issue #32365 (Enhancement) MIMIC: Change behavior of date option "All Data". In order to insure all data
for a query is returned, changed “All Data” to call executeQuery with invalid dates and the WHEN clause is
empty.

Issue #32663 (Enhancement) MIMICExcel: Would like Digital Cert for Install Code signed VBA Projects for
install.xls and mimicexcel.xla with certificate issued by Thawte.

Issue #32625 (Bug Fix) MIMIC: Custom rollover loses the "to last" property when changing number of days.
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(Bug Fix) MIMIC: Fixed bug when modifying rollover policy to retain the “to last” property when number of
days is changed.

Issue #32204 (Bug Fix) MIMICExcel: Button images causing problem in MIMICExcel add-in for Excel
version 9.x

Issue #32203 (Bug Fix) MIMICExcel: If chart or other object is selected and user enters MIMIC or refreshes
MIMIC queries they receive “error:Object variable or With block variable not defined”. Resolved by getting
address of active cell. If no cell is active then default to $A$1 of the active sheet.

Issue #32094 (Bug Fix) MIMIC: Bug with prompting of incorrect formula. When removing items from a
MIMIC worksheet with formulas, the app was prompting only if the user removed a formula. Corrected this
by having the app prompt user when any item is being removed from a worksheet containing formulas. This
is due to the fact that labels are changing and users formulas may be referencing the labels.

Issue #31512 (Bug Fix) MIMIC: If skip NaNs checked, Fill NaNs should be greyed out.

Issue #31249 (Bug Fix) MIMICExcel: Renaming query not working correctly, causes 2 queries to be saved.
The dialog for opening, editing, renaming or deleting saved queries has been redsigned making it more
intuitive and user friendly at the same time fixing the bug when renaming the query and resulting in 2 queries.

Release 3.1.0.4
Issue #30629 (Enhancement) MIMIC: Added “Fill Blank” option for Missing Data.

Issue #30631 (Enhancement) MIMIC: Added feature to synchronize all Time Units or Columns with
currently selected item.

(Enhancement) MIMICExcel: Changed dialog for opening, deleting, renaming and copying saved queries.
Made the dialog more intuitive when renaming a query.

(Bug Fix) MIMIC: Fixed bug when opening saved MIMIC files (.llc) by double clicking on the file in
Windows Explorer.

Issue #21925 (Bug Fix) MIMICExcel: Fixed bug when renaming a query and the comment on the cell was
not being updated.

Release 3.1.0.2
Issue #29450 (Bug Fix) MIMIC: Bug fix in "Search" panel when connected to server versions 4.5.06 and
older.

Issue #29451 (Enhancement) MIMIC: Added option when importing symbols to remove blank rows

(Enhancement) MIMIC: Modified Browser to be more responsive/informative.

(Bug Fix) MIMIC: Fixed bug in "Search" panel when selecting columns.
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(Enhancement) MIMIC: Added "mid*" to the columns in the "Search" panel.

Release 3.1.0.1
Issue #26518 (Enhancement) MIMIC: Added enhancement to import symbols from a .llc, .csv or .txt file.
Csv and txt files should be in the format: SYMBOL[,COLUMN] where column is optional. If the column is
omitted then the default column for the symbol will be used.

Issue #22813 (Enhancement) MIMIC: Added control for user to select orientation of the chart legend.
Possible orientations are horizontal and vertical. The user may also elect to have the legend anchored in the
North (default), West, South or East positions against the chart.

Issue #22332 (Enhancement) MIMIC: New seasonal analysis functionality giving user more control over
averages when running a seasonal analysis.

Issue #26428 (Bug Fix) MIMIC: Problem when opening MIMIC 3.02.2 - pop up screen: Launching MIMIC
3.0.2.1. Typo in the version string for the .exe. Fixed to reflect correct version.

Issue #27040 (Bug Fix) MIMIC: Hotlist unable to remove directories. Fixed hotlist dialog to remove
directories when user selects “Delete”.

Issue #25742 (Bug Fix) MimicExcel: Some installations were getting a runtime error “The object invoked has
disconnected from its clients”. This was due to libraries being loaded/unloaded in VB. When Mimic is ran
from Excel the Java code in Mimic will load the DLLs necessary for Mimic to run.

Issue #25612 (Bug Fix) MimicExcel: Run time error '9': Subscript out of range; Application-defined or
object-defined error. Bug when reference is lost and user tries to table or save the query. Fixed by capturing
the error and prompting user to reset the reference.

Issue #25565 (Bug Fix) MimicExcel: Getting runtime error 6 when running excel add-in. Caused by jvm.dll
already being loaded when the mimicexcel.dll tries to load and attach to the jvm. Fixed by not loading jvm.dll
specifically and allowing the Java plugin to load it.

Issue #25494 (Bug Fix) MimicExcel: Spreadsheets with several long running queries seems to hang when
refreshing. Fixed by having the VB code “pole” the library call that fetches the data returned by Mimic.
Upon completion of executing a Mimic query, the poling will end and data will be transferred to the Excel
spreadsheet.

Issue #21925 (Bug Fix) MimicExcel: Renaming a query does not update the name on the comment of a cell
within the Excel spreadsheet.

Release 3.0.2.2
Issue #21042 (Enhancement) MIMIC: Add Contracts feature hangs when hitting OK without entering in
fields. There was no bug. If the user clicks OK in the "Add Contracts" dialog without filling in the options,
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then every contract will be added. This can be a potentially long operation. The new release will display a
progress dialog showing the user exactly what is being added.

Issue #23436 (Enhancement) MIMIC: Display date in mm/dd/yyyy format when using Mouse pick. The
year was not being displayed in the chart's Mouse pick table. This has been corrected.

Issue #22712 (Enhancement) MIMIC: Need user option to show ".internal" folders. For internal use only.
Internal folders are filtered out of the browser tree by default. If the user wishes to view these folders they
must add the property "lim.browse.internal=true" to their userprop.txt file.

Issue #21770 (Bug Fix) MIMIC: Doesn't let you resize results window. Older version let you. Some users like
to compare tables by making the window small enough to only show the table and then place that window
next to another window with a table allowing them to eyeball each row. MIMIC will allow users to resize the
window to their desired dimensions.

Issue #22603 (Bug Fix) MIMIC: Bug handling of unit conversions when frequency changes.

Issue #22617 (Bug Fix) MIMICExcel: Bug output from seasonal analysis changes when refreshing from the
Excel view. When "refreshing" queries from MIMICExcel, the saved query's dates were not being reflected by
the MIMIC Worksheet model. Specifically if the saved query had "Relative" or "Today" specified for the start
and end dates. This has been fixed.

Issue #22718 (Bug Fix) MIMIC: Bug when sorting results, time does not sort correctly. Tables are now sorted
by Date and Time.

Issue #23365 (Bug Fix) MIMIC: Getting error when running 3 year calendar strip on HO. There was a bug
when charting a worksheet that had no data being displayed. Although data was returned by the query, there
was only one item set to be shown in the chart. This item had no data and an error occurs when trying to
build the axis. This has been fixed by displaying a message "No Data To Chart" back to the user.

Issue #21925 (Bug Fix) MIMICExcel: Renaming a query doesn't update the name on the comment
within Excel. In this release the comment tag is now being updated with the new name. Issue #22063
(Enhancement) MIMIC: Deselected "Show in Table" feature is not passed on to contracts when using "Add
Contracts" button. Newly added contracts will have the same properties as the base symbol.

Release 3.0.2.0
Issue #18984 (Enhancement) MIMIC: Add ForwardFill to “end date”

Issue #18433 (Enhancement) MIMICExcel: Added “Advanced Refresh Mode” allowing users to modify the
date range when refreshing queries.

Issue #20604 (Enhancement) MIMIC: AddContracts allows user to select columns with no data. Customer
requests to be warned or blocked.

(Enhancement) MIMIC: Check symbol text field for changes when chart/table action occurs. If changed,
then update table with symbol.

(Enhancement) MIMIC: Foundation for Forward Curves added. Only available for demos.
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Issue #19360 (Bug Fix) MIMIC: Bug in hotlist when non-hotlist files exist.

Issue #20116 (Bug Fix) MIMIC: “Edit Chart Stats” not visible until the window is resized.

Issue #20445 (Bug Fix) MIMIC: Curve Matrix ignores column selected and defaults to Close.

Issue #20784 (Bug Fix) MIMIC: Symbol not being trimmed resulting in error.

Release 3.0.1.6
Issue #18235 (Enhancement) MIMIC: Display Java run-time version in Help>About.

Issue #18985 (Enhancement) MIMIC: Add shortcuts.

(Enhancement) MIMIC: MIMIC remembers the status of the browser when exiting.

Issue #17479 (Bug Fix) MIMIC: not displaying answers correctly for seasonal analysis queries.

Issue #17797 (Bug Fix) MIMIC: Possible bug with MIMICExcel using copy function.

Issue #18128 (Bug Fix) MIMIC: Bug with charting seasonal analysis.

Issue #18683 (Bug Fix) MIMICExcel: Runtime Error: Object doesnt support this action.

Issue #18686 (Bug Fix) MIMICExcel: Error when deleting Excel Sheet with MIMIC queries.

Issue #17266 (Bug Fix) MIMICExcel: Doesn't handle bad location reference elegantly.

Release 3.0.1.5
Issue #16785 (Enhancement) MIMICExcel: Add location to Sheets dialog (when opening saved queries).

Issue #16210 (Bug Fix) MIMIC: Graphs will not print in color.

Issue #16214 (Bug Fix) MIMIC: Printing a chart comes out as a "red" block.

Issue #16423 (Bug Fix) MIMIC: Looks like the modifier "front" is missing from MIMIC.

Issue #16701 (Bug Fix) MIMIC: Custom contract becomes grayed out when moving the highlighting from a
non-future to a future.

Issue #16521 (Bug Fix) MIMICExcel: sheet load blows up.

Issue #16863 (Bug Fix) MIMICExcel: Dates are not formatted/aligned properly for European settings.

Issue #16187 (Bug Fix) MIMICExcel: Status Bar disappears.

Issue #16334 (Bug Fix) MIMICExcel: When opening a MIMIC query, get a Base64FormatException.
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Release 3.0.1.3
(Enhancement) MIMIC: Screening criteria categorized. Screener rc2 required.

Issue #15724 (Enhancement) MIMICExcel: Label a query created by the conversion tool with its location.

Issue #15780 (Enhancement) MIMICExcel: Add a Menu for MIMICExcel & if new version of Excel, add
buttons in toolbar.

Issue #15562 (Bug Fix) MIMIC: Bug with crashing with four monitors.

Issue #15677 (Bug Fix) MIMICExcel: Update Problem when MIM query returns zero results.

Issue #15681(Bug Fix) MIMICExcel: When a query is opened, the Locator does not update with the new
address.

Issue #15736 (Bug Fix) MIMIC: Columns do not exist in tree for ICE.CINERGY.

Issue #15983 (Bug Fix) MIMICExcel: VBA error when no workbook open and user launches MIMIC.

Release 3.0.1.1
(Enhancement) MIMIC: Added Screener panel.

(Enhancement) MIMICExcel: Added Conversion Wizard to convert MIM-Excel queries to MIMIC llc
worksheets.

Issue #15724 (Enhancement) MIMICExcel: Label queries created by converter with its location

Issue #15550 (Bug Fix) MIMIC: Default column for futures contracts was selecting "Continuous" if no
“default” column found.

Issue #15681 (Bug Fix) MIMICExcel: Update ref_edit control with new address when "Edit" query is
selected.

Issue #15677 (Bug Fix) MIMICExcel: conversion hangs when no data found.

Issue #15172 (Bug Fix) MIMIC: Bug when no trade segments for category/relation

Issue #14988 (Bug Fix) MIMIC: Bug when restoring default chart colors

Release 3.0
Issue #11243 (Enhancement) MIMIC: Added "Print Options" panel to "User Options". Allows user to set
print orientation.
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Issue #12668 (Enhancement) MIMIC: Added 1 Day ago, 2 Days ago, and 1 Week ago to MIMIC's period
combo box. (02/12/2004).

Issue #12926 (Enhancement) MIMIC: Added a check box to MIMIC's Login Screen to allow the user to save
login info. (02/02/2004).

Issue #12670 (Enhancement) MIMIC: Added on "Chart" button when in "Configuration" mode. (Was
commented out) (02/02/2004).

Issue #12578 (Enhancement) MIMIC: Added scrollbars to hotlist. Added "Insert" mode to hotlist panel.
(02/02/2004)

Issue #10548 (Enhancement) MIMIC: Added GUI for storing formulas on server (02/02/2004)

Issue #11296 (Enhancement) MIMIC: Improved performance of slow queries. Fixed by reducing the amount
of message logging.

(Enhancement) MIMIC: Added capability for user to change the "Rounding Mode" via "User Preferences"
dialog.

(Enhancement) MIMIC: Added "Look and Feel" to MIMIC's "Options" menu. (02/12/2004).

(Enhancement) MIMIC: Improved performance when adding contracts. Significantly improved performance
when accessing remote MIM Servers via VPN. (03/15/2004).

(Enhancement) MIMIC: Improved browsing facilities. Faster browsing. Icons distinguish between normal
relations and futures, columns and default columns.

Issue #10525 (Bug Fix) MIMIC: Units of measure conversions when server config is switched to XML/RPC
or XML/HTTP.

Issue #13375 (Bug Fix) MIMIC: During installation, default color properties were not be written correctly.
(02/02/2004).

Issue #13352 (Bug Fix) MIMIC: When sorting tables with no Summary Stats, the last few item were not
shown. (02/02/2004).

Issue#14005 (Bug Fix) MIMIC: Removing a row stops user from amending formulas. (02/19/2004).

Issue #14942 (Bug Fix) MIMIC: Formatting bug when value is NaN.

Issue #14943 (Bug Fix) MIMIC: Do not treat collapsing tree as a "selection" when previously selected node is
descendant.

Release 2.1.3
Issue #11296 (Enhancement) MIMIC: Slow queries. Fixed by reducing the amount of message logging.
(10/10/03).
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Issue #11243 (Enhancement) MIMIC: Added "Print Options" panel to "User Options". Allows user to set
print orientation. (10/06/03)

Issue #11457 (Bug Fix) MIMIC: Fixed bug when adding contracts. (10/16/03)

Issue #10822 (Bug Fix) MIMIC: MIMIC bug in Seasonal Analysis - if show in chart/table not checked - still
shows the heading in table (10/13/03)

Issue #10525 (Bug Fix) MIMIC: Fixed bug for units of measure conversions when server config is switched
to XML/RPC or XML/HTTP (09/15/03)

Release 2.1.2
Issue #10612 (Enhancement) MIMIC: Buttons on MIMIC are replaced by “Please wait while the program
fetches data from the server”

Issue #10457 (Bug Fix) MIMIC: Getting errors when trying to save worksheet using MIMIC 2.1.2

Release 2.1.2
(Enhancement) MIMIC: Added "Avg Weekly", "Quarterly" and "Avg Quarterly" to canned queries.

(Enhancement) MIMIC: Filter for returning current month when monthly exec units selected.

Issue #10159 (Bug Fix) MIMIC: When using the "Add Contracts" button MIMIC got confused when it
saw continuous relations with names like NG_19, thinking that "19" was a contract year. Now it identifies
contracts using regular expression to match [A-Z][A-Z]_\d\d\d\d.

Release 2.1.1
Issue #7625 (Enhancement) MIMIC: Modified error message for "null" formulas to be more meaningful.

(Enhancement) MIMIC: Symbol Browser changed how futures contracts and continuous relations are
displayed.

Issue #7524 (Bug Fix) MIMIC: Fixed bug to set "Time Units" to default to "Daily" when previous llc item is
null or does not have "Time Units". (i.e., formulas).

Issue #8584 (Bug fix) MIMIC: Got NaNs for seasonal analysis queries.

(Bug Fix) MIMIC: Only allows selection of "Day", "Weeks" or "Months" for seasonal analysis queries.
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Release 2 2002/12/06
Issue #5647 (Enhancement) MIMIC: Removed the 3x connection from MIMIC GUI and from the installer
GUI. The connection can still be used just not setup by the user.

Issue #5533 (Enhancement) MIMIC: MIMIC will report when it can not connect to a server and if the user
is not entitled to view data.

Issue #4681(Enhancement) MIMIC: Added the forward curve functionality.

Issue #4572 (Enhancement) MIMIC: Added the ability to move and copy the table items.

Issue #5747 (Bug Fix) MIMIC: MIMIC was treating 0 as positive number, now it treats them as neither
positive or negative.

Issue #6016 (Bug Fix) MIMIC: When seasonal is checked and the change period field is used the start date
has a single day added to it plus the period change that that was selected.

Release 2 2002/09/09
(Enhancement) MIMIC: Added copy chart feature.

Release 2 2002/08/28 and 2002/09/04
(Enhancement) MIMIC: Added feature to force the seasonal calendar to seven day pattern.

(Enhancement) MIMIC: MIMIC now runs and is shipped with the 1.4 JRE.

(Enhancement) MIMIC: Added the ability to chose hotlist location during install.

(Enhancement) MIMIC: Added the JavaScript engine.

(Enhancement) MIMIC: Added the ability to chose chart save location during install.

(Bug Fix) MIMIC: Fixed bug when trying to pull seasonal data and no is returned.

(Bug Fix) MIMIC: Fixed bug with incorrect data at the end of seasonal table.

(Bug Fix) MIMIC: Fixed bug with trying to add contracts Jan-Jan.

(Bug Fix) MIMIC: Fixed bug with zero line when charting.

(Bug Fix) MIMIC: Fixed error message when password is incorrect.
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(Bug Fix) MIMIC: Fixed bug with %change and deltas not being calculated when using the mouse pick.

Release 2 2002/04/19
(Enhancement) MIMIC: Sort contracts in add contracts in case the server returns them out of order.

(Enhancement) MIMIC: Added daily when execution units daily to conversion factor.

(Enhancement) MIMIC: Added multi-colored candlesticks to the charts.

(Enhancement) MIMIC: Added ImpVol and Val to default column pecking order.

(Bug Fix) MIMIC: Fixed Summary stats "PctNeg", does no longer return a value when all date is positive.

(Bug Fix) MIMIC: Fixed the charts so that it displays dates in the users date format.

(Bug Fix) MIMIC: Monthly data extraction now forces day to 1st of month. Fixes problems with monthly
seasonals.

Release 2 2002/04/12
(Enhancement) MIMIC: Added support for forcing 7 day trading pattern.

(Enhancement) MIMIC: Added support for UK dates in mouse pick and x axis.

(Enhancement) MIMIC: Added support for fill nearest.

(Enhancement) MIMIC: Now automatically paste in Excel without the new worksheet.

(Bug Fix) MIMIC: Fixed null pointer and other problems charting.

Release 2 2001/11/01
(Bug Fix) MIMIC: Fixed problem with incorrect date scale of the chart.

(Bug Fix) MIMIC: Fixed problem with the Add Contracts Dialog hanging.

Release 2001/09/10
(Enhancement) MIMIC: Added "MIMIC Password Check" box to the installer.
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Release 2
(Bug Fix) MIMIC: Fixed problem with the data box being to small to display the last line of data (In chart
pick mode).

Release 1 2001/08/23
(Bug Fix) MIMIC: Fixed problem with summary statistics containing data outside the data range specified.

Release 1 2001/07/18
(Enhancement) MIMIC: Start and End date now is used to filter MIM data to avoid extracting data fills from
Saturday or Sunday dates with Friday values. For, example, 7/1/2001 would return 6/29/2001 as a fill. Now
the dates will be confined to the range in the MIMIC GUI.

(Enhancement) MIMIC: Changed the add contracts dialog to return all contracts between the start and end
year and the start and end month. The prior behavior was to return all of the contracts from the start year
and start month or the end year and end month. This should make extracting all contracts of a month or
season strips much easier.

Release 1 2001/03/06
(Enhancement) MIMIC: Created new install package. It is a single file self-extracting executable.


